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How to Test Layer 3 Switches

with ML-7710 SmartCards & SmartWindow

A Guide for Evaluating the Performance of

Layer 3 Devices

using Netcom Systems SmartBits Performance Analyzer and Software

Netcom Systems is pleased to provide a general procedure for testing Layer 3 device performance. The
SmartBits chassis, multi-layer ML-7710 SmartCards, and an easy-to-use SmartWindow program are the
tools to provide a test methodology which is highly effective in providing critical data to evaluate Layer 3
devices.
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Part I: Introduction

What is a Layer 3 Switch?

In most cases, a Layer 3 switch is in fact a fast protocol-based router minus certain router functions.  A
Layer 3 switch typically works with only one or two protocols, performs at or close to wire speed, is good
at keeping streaming packets in order, and makes routing decisions based on ASICs (unlike a router
which is software-based).

The 10 Mbps, 100 Mbps and Gigabit Ethernet Layer 3 switches are expected to operate at full line-rate at
Layer 2 and wire-speed IP routing at Layer 3 simultaneously on all ports with zero packet loss and
extremely low latency.

Test Methodology

SmartWindow is a highly effective front panel GUI designed for developers and QA personnel, who wish
to create traditional and custom tests.  SmartWindow offers test parameters recommended in the
following supported RFCs:

RFC 1242, Benchmarking Terminology for Network Interconnection Devices

RFC 1944 , Benchmarking Methodology for Network Interconnect Devices

The ML-7710 SmartCard can simulate up to 1000 hosts sending varied or uniform traffic to the layer 3
switch and can fully characterize the switch on both Layer 2 and Layer 3.

The SmartWindow tests and results which demonstrate the performance capability of the switch include
the following topics:

♦ 20 Counters (transmit and receive packets and bytes, packet loss, triggers, tags, collisions,  errors,
ARP and ping counters)

♦ Sequence Tracking data

♦ Latency Distribution data

♦ Latency over Time data
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Sample Layer 3 Test Results
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What is a Stream?

It is essential to understand  SmartBits streams which provide the basis for using the ML-7710 traffic and
test capability.  Each stream, generated by its own Virtual Transmit Engine (VTE), represents a repeated
packet with the following features:

♦ Designed to set up traffic for testing layer 2 (switching) or layer 3 (routing) .

♦ A signature in each packet contains its source and destination location, its sequence in the traffic
flow, and when it was sent and received.

♦ Each stream has its own IP/MAC source and destination addresses, frame length, protocol or custom
packet, IP gateway for routing, and statistics/histogram tracking capability.

♦ With IP, each stream also has ARP request and response ability.

♦ The stream of one card typically transmits to the stream of another card, simulating transmission from
one host computer to a second host computer.  Both can be on the same subnet or on different
subnets.

♦ If 10 streams are defined, the 10 packets are transmitted in the order created, then re-cycled to
transmit the next 10, until the transmission is stopped.  If only one stream is created for a card, then
the traffic is comprised of the one packet type.

♦ Each ML-7710 SmartCard may transmit up to 1000 streams per card, and may track
statistics/histogram information on up to approximately 80,000 streams.

Unlike the older SmartCards such as the SX-7410 Ethernet SmartCard which is a packet blaster for hubs
and switches, the ML-7710 is equivalent to 1000 IP connections, now condensed into a simple format for
creating 1000 streams which closely mimic real world traffic.

Place 20 ML-7710 cards into a SmartBits chassis, then stack 4 chassis; with 80 cards, you can arrange
up to 80,000 streams.

Hard Disk Requirements for Streams

If you set up 1000 streams, the setup configuration for each card can take 5 to 7 Mbytes of hard drive
(see saved *.msi files).

Multiply by 20 cards = 120Mbytes of hard drive per test setup

Multiply by 4 chassis = 480Mbytes of hard drive per test setup

If you want to make histogram measurements, double your estimated hard drive requirement.

Other Applications Available

More tests are available with the ML-7710.  These will be presented in another paper in the near future.
The additional applications are: 

♦ SmartApplications
SmartApplications is a Windows®-based application software program that works with SmartBits systems. These
applications automate RFC 1242 testing for determining Throughput, Packet Loss, Latency, Back-to-Back
Performance testing under full load, and production Go/No-Go tests for “minimum acceptable” performance
levels. Tests are available for Ethernet, Token Ring, ATM, and Frame Relay.

♦ Advanced Switch Tests (AST)
AST is an easy to use Windows-based application software program that generates heavy bursts of
multidirectional traffic to test 10/100/1000 Mbps Ethernet and 4/16 Mbps Token Ring networks. The application
can test requirements described in RFC 2285, and includes tests for head-of-line blocking, filtering illegal frames,
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backbone switching, forward rate/IFG, address handling, broadcast frames, and fanout, for Ethernet and Token
Ring networks in half or full duplex mode.

♦ VAST
VAST is an easy to use Windows-based application that generates heavy bursts of multidirectional stream-based
traffic to test switches, routers, and VLANs. The application includes preprogrammed tests for VLAN by port,
VLAN by MAC address, VLAN by tag, VLAN by IP subnet, VLAN by protocol, VLAN setup time, filtering illegal
frames, many-to-many switching, and routing between VLANs. At least two ML-7710 SmartCards are required to
perform these tests.

♦ SmartLib Programming Library
SmartLib provides an RFC 1242 API compliant programming library interface for rapid test development.
Software developers may also use it to develop programs in Visual Basic, C, or C++ in a Windows 95
environment, and C, C++ or TCL in a UNIX® environment.

PART II:
Setting One Stream per Card & Displaying Counters
This section presents introductory startup procedures and a basic test scenario based on a single stream
from each SmartCard:

Procedure 1:     Default Global Settings to Review

Procedure 2:     Preferences to Review

Procedure 3:     Setting Up One Layer 3 Stream per ML-7710 SmartCard

Procedure 4:     Pinging to Check Links

Procedure 5:    Transmitting Traffic and Viewing Counters

The test configuration illustrated in the first five procedures has the following connections:

♦ Two ML-7710 SmartCards are installed in slots 16 and 17 of a SmartBits chassis

♦ The SmartBits chassis is connected to a PC with SmartWindow via an Ethernet port.

♦ The two ML-7710 ports of the SmartBits chassis is connected to two gateway ports on the Layer 3
switch/router (Device under Test).

The two subnets and related IP addresses are shown in the illustration below:

Preparing the Device Under Test (DUT)

IMPORTANT: SNMP functionality, proprietary polling and Spanning Tree frames
generated by the DUT will lower the measured performance of the DUT. It is
recommended that you turn off all traffic generated by the DUT in order to get actual
performance of the switching fabric.

                    DUT
             146.72.1.1 147.72.1.1

                        146.72.1.10          146.72.x.x                                                                                        147.72.x.x     147.72.1.10
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Procedure 1:  Default Global Settings to Review

The default settings of each SmartCard should be checked to ensure that they are still appropriate.

1. Open SmartWindow .

2. In SmartWindow, click on each ML-7710 SmartCard, and select the Layer 3 Mode .

3. Click on each ML-7710 SmartCard, and select the Transmit Setup  command.

4. In the Transmit Setup window, click the This Port  button to view the default global settings for the
card.  Most fields are optional.

           Transmit Mode

      Interpacket Gap
     set by default for
     FULL WIRE RATE

     Error Generation (added to
     each packet if selected)

Background fill
pattern inside the
IP packet (between
the IP header and
signature field).
Custom default is
often used.

Used in Layer 2
mode only;
disregard for Layer
3 mode.
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Procedure 2:  Preferences to Review

There are three preferences which merit quick consideration. Click the Options menu Preferences
command.

♦ The default inter ARP gap is set to 9.6 usec as a standard specification and by default cannot be
changed for a SmartCard. However, if you wish to change this gap (for instance, a switch cannot
process ARP requests at full wire speed), you must turn on the Preference checkbox for Allow time
control of ARP requests .  Then you can re-set the inter ARP gap for each port as needed (click the
SmartCard and select Layer 3 Setup ).

♦ To automatically update (with speeds, duplex mode, and autonegotiation settings) the Fast Ethernet
cards with the last saved configuration or a newly opened configuration file, click the checkbox for
Restore MII Control register 0 after File/Open .

♦ To allow MII auto-negotiation for all the Fast Ethernet SmartCards, check the checkbox for Allow MII
Auto-Negotiation .  Then to selectively enable auto-negotiation for each or any SmartCard, click the
SmartCard, select MII Registers , and click the checkbox for Enable Auto-Negotiate .
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Procedure 3:  Setting Up One Layer 3 Stream per ML-7710 SmartCard

This procedure shows how to configure a single stream in each of two ML-7710 SmartCards (ports 16
and 17 of an SMB-2000 chassis) with SmartWindow 6.25.  The SmartBits chassis is connected to a layer
3 switch.  It is helpful to set up address assignments in patterns that are easy to remember and
interconnect.

IMPORTANT   The MAC and IP addresses of streams must be unique  to the streams and cannot be
used for ports.  The IP address of a stream or a port should be on the same subnet of the associated
gateway.

1. In SmartWindow, click on the ML-7710 port 16 SmartCard, and confirm that the Layer 3 Mode  is
selected.

2. Click the SmartCard again, then select Layer 3 Setup  command.

The Layer 3 Setup window describes the local stack and is optional for most testing requirements.
This window is edited for the following purposes:

--  to set the gateway IP address of the router port (DUT) -- REQUIRED for Layer 3 switches
--  to change MAC and IP addresses (if needed) so that they do not duplicate stream addresses
--  to set the netmask for management frames if needed (optional; ignored by streams)
--  to specify a Ping IP address for pings and SNMP frames if needed (optional)
--  to specify frequency for Ping, SNMP, or RIP (optional)

Switch/Router

Switch Gateway Ports:
    146.072.001.001
    147.072.001.001

SmartBits 2000 Port 16 Port IP address:      146.072.001.003  - Optional
Port 16 Stream IP address: 146.072.001.010
Gateway for Port 16:            146.072.001.001

Port 17 Port IP address:      147.072.001.003 - Optional
Port 17 Stream IP address: 147.072.001.010
Gateway for Port 17:           147.072.001.001

PC with
SmartWindow
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  Port 16 Layer 3 Setup:  Set the MAC and IP addresses and gateway address as shown below.
Gateway is the IP address of router port.  MAC address is for the card (not
stream). The IP address must be in the same subnet as the router
port/gateway. Once addresses are entered, click OK.

IMPORTANT  FOR ARP EXCHANGE  :  The gateway IP address is the target address for ARP frames. If
the gateway IP address is zero, the ARP frames will target the destination IP addresses of the streams.

3. In the Transmit Setup window, highlight the default stream and click the Delete  button. The default
stream will be replaced with new fully defined streams.

4. Click the Add VTEs  button to add a stream onto port 16.  Select IP from the Protocol pulldown menu,
and click OK.  In the Protocol Editor, toggle the View menu Concise/Detail  command to see more
fields. Enter the necessary addresses.

Stream on Port 16

The MAC Dest is the MAC address of router port; it is automatically updated via ARPs; note that
when the ARP response is received, the ARPs are handled internally and not updated here.  The
MAC Src is the MAC address of the stream.  The Source IP is the IP address of the stream. The Dest
IP is the destination or target IP address.

 Do not enter router MAC              User-defined MAC                                  Source IP address      Destination IP address
 address (ARPs do it)                    address for STREAM                              for local stream          for destination stream

For SmartCard port only. Often no entries are
added here. We use the IP address as a way to
ping and check links. Ensure  that these
addresses DO NOT duplicate stream addresses.

Netmask used only with management frames.

REQUIRED  IP address of router port/gateway.
This is also the default gateway for all streams.
Gateway is only used for routers or Layer 3
switches.
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5. Now configure the port and stream for ML-7710 Port 17.  Click the port 17 SmartCard and select
Layer 3 Setup  command.

Port 17 Layer 3 Setup: Set the MAC and IP addresses and gateway address as shown below.
Remember, the CARD must have a different MAC and IP address than any of
the streams. Once addresses are entered, click OK.

 Stream on port 17:      Click the port 17 SmartCard and select Transmit Setup .  Highlight the default
stream and Delete . Click the Add VTEs  button to add a stream onto port 16.
Select IP from the Protocol pulldown menu, and click OK.  In the Protocol
Editor, toggle the View menu Concise/Detail  command to see more fields.
Enter the necessary addresses. Be sure to press the Enter key after each text
entry to save it. Click the Close button to exit the window.

   Note that Source and Destination IPs are mirrors of the settings on port 16.
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6.     When complete,  send Layer 3 ARPs from each card by clicking on each SmartCard and selecting
Layer 3 Send ARP Requests.  This is necessary to learn the MAC destination addresses.

Alternatively, you can select Actions menu Layer 3 ARP  command to send ARP requests from ALL
configured ports at one time.

WATCH THE SMARTBITS HARDWARE  or SmartWindow front panel LEDs :   As each SmartCard
transmits an ARP request, look for a brief green LED for transmit and receive. If you do not see a
momentary green LED light for receive, the ARP response was not received.

For many streams and ARPs, perform the ARP Exchange Times test (Procedure 10) to ensure that
ARPs for all streams were received.
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Procedure 4:  Pinging to Check Links

Before transmitting traffic, it is worthwhile to ping the SmartCard IP addresses to confirm that the links to
the DUT are working properly.

To ping each SmartCard:

1. Click on port 16, select Layer 3 Setup , enter the target IP address for port 17, and set the ping
frequency to 10:

Click OK.

2. Click on port 17, select Layer 3 Setup , enter the target IP address for port 16, and set the ping
frequency to 10:

       Click OK.

3. To view counters for pings, click Actions menu SmartCounters  command, then select the File menu
New Counter Window  command. Highlight ports 16 and 17.

4. Click on the Start  command on each SmartCard and watch SmartCounters for the ping counters.

5. After the pinging is performed, go back to the Layer 3 Setup of each card to turn off pinging by setting
the Ping Frequency to O.   This will keep other traffic results more clearly defined.



How to Test Layer 3 Switches  15

Check SmartCard Speed Setting

If the link is still not active , check that the correct speed  is selected (default is 10Mbps and you may
require 100Mbps). To reset the SmartCard speed, click on each card, and select 100Mbps  on the main
menu of each SmartCard.

Procedure 5:  Transmitting Traffic and Viewing Counters

Now you are ready to transmit traffic and view counters.

1. Click on the port 16 SmartCard, and select Display Counters  to view results during transmission.
Repeat for the port 17 SmartCard.

Or select Actions menu SmartCounters command, then select File menu New Counter Window
to view all counters. You can save SmartCounters to an excel spreadsheet file with the File menu
Save As  command.

2. Click Start  on transmitting SmartCard to start transmission. For bidirectional transmission, click Start
on both SmartCards.
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PART III:
Setting Multiple Streams per Card & Displaying Counters
This section presents detailed procedures for creating and using multiple streams on two ML-7710
SmartCards, and then producing counters and test results:

Procedure 6:  Setting Up 20 Streams per ML-7710 SmartCard

Procedure 7:  Creating SMB Group, Transmitting Traffic, and Viewing Counters

Procedure 6:  Setting Up 20 Streams per ML-7710 SmartCard

The following procedure describes how to quickly set up 20 consecutive streams from each SmartCard,
with varied IP and MAC addresses as well as with varied packet lengths.  If desired, you can also assign
different protocols and add up to 1000 streams to further mimic real world networks.

Switch/Router

Switch  Gateway Ports:
    192.005.001.254
    192.006.001.254

SmartBits 2000
Port 5 Port IP address:          192.005.001.025
Port 5 Stream IP addresses: 192.005.001.005 - 192.005.001.024
Gateway for Port 5:                192.005.001.254

Port 6 Port IP address:          192.006.001.026
Port 6 Stream IP addresses: 192.006.001.006 - 192.006.001.025
Gateway for Port 6:               192.006.001.254

PC with
SmartWindow

Test Setu p

Simulation of a network of 40 PC Hosts sending and receiving traffic  through the DUT

DUT
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1. Open SmartWindow.

2. Click on ML-7710 port 5. Click the Layer 3 Mode  command.
For Port 5 :  Click the card again and select the Layer 3 Setup  command.
Enter the gateway IP address for port 5: 192.005.001.254. Click OK.

NOTE The  IP ADDRESS for each port is  OPTIONAL and is added here only to allow for pinging.

3. Click on ML-7710 port 6. Click the Layer 3 Mode  command.
For Port 6 :  Click the card again and select the Layer 3 Setup  command. Enter the gateway IP
address for port 6: 192.006.001.254. Click OK.  

4. Click on the port 5 SmartCard and select Transmit Setup . Highlight the default stream and click the
Delete  button.  It is helpful to delete the generic stream and then enter all new streams at one time.

5. Now click Add VTEs button to add 20 streams:
Enter 20 VTEs. Click the Randomized  radio
button for Frame Length. Select IP for the Protocol.

NOTE  We recommend that you start with Fixed
frame lengths to set initial testing benchmarks, then
try randomized frame lengths in contrast.

6. Click OK. The Protocol Editor appears with default addresses for 20 streams (see next page).

7. Edit the first stream as follows:

        Source IP address for the first stream:       192.005.001.005
        Destination IP address for the stream (which is a port 6 VTE stream): 192.006.001.006

Then highlight each column (the SourceIP, then DestIP) individually, right-click on the first entry,
select the Copy Down  command, then select the Fill Increment 0.0.0.x.   The Edited Screen on the
next page shows the last column highlighted after these commands have been applied.
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Default Screen

Edited Screen

REQUIRED.  User-specified entries
are required for SourceIP and DestIP.

NOTE  You can optionally change the
Mac Src addresses (using the same
copy and increment commands) so
the DUT thinks that the streams came
from 20 different devices.

This minimum configuration indicates
that the streams are coming from the
same physical device.

Keep MAC address defaults. SmartBits handles MAC addresses
internally.
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8. Click the Close button and view the 20 streams for port 5 in the Transmit Setup window. Click OK.

9. Repeat above steps 1 through 7 for port 6  using the following IP addresses. Use the port 5
addresses for Destination IP addresses.

Port 6 Stream IP addresses:    192.006.001.006  through 192.006.001.025
Gateway for Port 6:                  192.006.001.254

10. Click Actions menu Layer 3 ARP  to send ARP requests to all configured ports.  To check that all
ports have sent and received ARPs, you can perform the ARP Exchange Times test (see Procedure
10).

11. To confirm that the SmartBits links to the DUT are working properly, ping the port IP addresses as
shown in Procedure 4.
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Procedure 7:  Creating an SMB Group, Transmitting Traffic, & Viewing Counters

1. It is handy to start all transmissions of multiple SmartCards
at the same time. To do this, click on SMB Group and
select Set Group .

Click the None  button to clear all ports, then click on port 5 and
port 6 boxes for the group. Then click OK.

2. To see results of multiple SmartCards on a single screen, click the Actions menu SmartCounters
command. Then select the File menu New Counter Window command.  Highlight the port numbers
whose counters you wish to view (here ports 5 and 6). Keep this window open.

3. Click View menu Show  command and check the boxes for rows and columns.

4. To define a custom indicator, select an empty cell to the right of the cells where data will be entered.
Left-click inside this cell, then insert your math equation (press F2 twice ) using spreadsheet
conventions.

5. Now click on the Start  command on the SMB Group and watch the SmartCounters.
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Part IV:  Detailed Tracking and Statistical Results
This section provides procedures which demonstrate latency and sequence tracking tests, raw packet
results, and data capture.

Procedure 8:  Performing Latency and Sequence Tracking Tests

Procedure 9:  Inspecting Raw Packets

Procedure 10:  Using Triggers and Capture

Procedure 8:  Performing Latency and Sequence Tracking Tests

The Latency and Sequence Tracking tests provide valuable statistical data for performance analysis of
the Layer 3 switch/router.

Before running these tests, confirm that your links are alive.
                                                    Note that the Link on the SmartCard indicates an active link to the DUT.

In this example, the following parameters are set up with the 20 streams for ports 5 and 6 set up earlier:

♦ Transmit Setup:  Continuous  Mode, 9.6 usec interpacket gap for 100% utilization

♦ Frame length for all streams:  60

1. Select Actions menu Layer 3 Send ARP Requests .

2. Click Start  on port 5 SmartCard.  Note the green transmit LED on  port 5 and the green receive LED
on port 6.

3. To see data from the transmitted traffic from port 5 to port 6, click Options menu Layer 3 Tests .
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Sequence Tracking

4. Select Test Type Sequence Tracking test, select checkboxes for Tx Port 05 and Rx Port 06, then
click Start  button at the bottom of the window.  After several seconds, click Stop  button.  Then click
Results  button and select the receive card, port 06.

5. To set a lighter load and determine the rate at which there is little or no packet loss, click the port 5
SmartCard, select Transmit Setup ,  and click This Port  button.  From the pulldown menu for
Interpacket Gap, select % Utilization  and enter 90 in the Rate box.  Click OK.  Click OK again and
close the Transmit Setup window. Click Start  on the port 5 SmartCard to transmit traffic and view the
Sequence Tracking.

Total frames received per stream
           Total frames received per stream in correct sequence
                                    Total frames lost per stream
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6. After a few more test runs, the 80% load produced the following sequence tracking.  You may wish to
repeat this test a number of times over a period of time to track the consistency of the router and
potential interruptions during the same and different loads, with increased or decreased number of
streams, with varied frame lengths (either fixed or random).

The remaining tests are run at the 80% utilization rate with the same switch.

Latency Tests

7. Select Test Type Latency over Time .  Click Start  button, run for a few seconds, then click the Stop
bottom. Click Results  button and select the receive port 06.

An ideal switch would slightly increase latency for a short time; latency would remain constant for
most of the test, then decrease as the ML-7710 stops transmitting.  An increasing latency from start
to finish indicates that the switch cannot handle the load for long sustained periods. As the latency

After approximately 1
second, the latency dropped
to a reasonable level.  A
possible cause of this
change is the use of a Fast
Path mechanism.
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increases, the switch buffers more frames. A spike in the latency indicates a problem with buffer
scheduling and warrants more investigation.

8. Here we now take a closer look at the Latency per VTE.  Continue to send traffic. Select Test Type
Latency per VTE .  Click Start  button, run for a few seconds, then click the Stop  bottom. Click
Results  button and select the receive port 06. Here again the spikes in latency are apparent.

The 20 streams are summarized with the minimum, maximum, and average for each stream.  The
latency range is relatively wide.

After approximately 1 second,
the latency dropped to a
reasonable level.  A possible
cause of this change is the use
of a Fast Path mechanism.
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9. With the traffic still running, select Test Type Latency Distribution .  Click Start  button, run for a few
seconds, then click the Stop  bottom. Click Results  button and select the receive port 06. Here the
latency has dropped dramatically, to the later low level shown in step 7, so that the 13.4 to 14.2 msec
shows consistently under the 20 msec time interval.

Procedure 9:  Inspecting Raw Packets

To look closely at the content of the last 131,000 packets received, you use the Options menu Layer 3
Tests command and the Test Type Raw Packet Tags .

1. Here you may wish to try  full wire rate in burst mode.  To do this,  click the port 6 SmartCard, select
Transmit Setup,  and click This Port  button.  Set mode to Single Burst and Interpacket Gap to 100%
utilization which will create a 10-second burst at full wire rate.  Click OK.
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Note that the two active ML-7710 SmartCards show the live Link status and the Burst mode.

2. Click the Start  button on the port 5 SmartCard.

3. Now select Options menu Layer 3 Tests  command and the Test Type Raw Packet Tags .

4. Click the Start , Stop , and Results  buttons to view raw packets in detail.

Live Link

Burst Mode
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Procedure 10:  Viewing ARP Response Times

It can be helpful to look at ARP response times which may vary with traffic load, time of day, and the
characteristics of each switch.  The ARP response times also confirm that all ports are sending and
receiving ARPs properly.

To perform an ARP exchange and view the ARP response times :

1. Select the Options menu Layer 3 Tests  command.

2. From the Test Type pulldown menu, select ARP exchange times .

3. Click on ports 16 and 17 for Tx and Rx Ports.  Each port will send ARPs to the DUT and receive an
response time for each stream.

4. Click the Start  button.  After a few seconds, click the Stop  button.

5. Click the Results  button and select port 16 results.  Then click port 17 results. A separate results
window appears for each port.
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Procedure 11:  Using Triggers and Capture

A trigger is a pattern counting tool which "triggers" a count of any packets holding a specific pattern
located inside any of the packets received by the receive SmartCard.  You can track one or two triggers
per receiving SmartCard in any combination (singly or together).

The pattern is defined:

♦ in the transmitting SmartCard

♦ in the Trigger Setup of the receiving SmartCard

To see the trigger count, you send traffic, click the receive SmartCard, select the Display Counters
command, and check the Trig counters.

To view details of each triggered packet, you can use one or both of the following methods:

♦ Select the Options menu Layer 3 Tests  command, select the Test Type Raw Packets Tags , send
traffic, and run the test  (click Start, Stop , and Results  buttons).

♦ Click the receive SmartCard,  select the Capture  command, select the Capture Packets with Rx
Triggers , and send traffic to be captured.

Setting Triggers and Displaying Counters

In the following example,  the first stream of port 5 targets the first stream of port 6 (IP address
192.006.001.006 which has the MAC source address 000000002016).  In this case, no custom transmit
setup is necessary.

1. Click on the port 6 SmartCard and select the Trigger Setup  command.

2. Keep the Offset of 0 (for the MAC Destination Address) and the Byte Length of 6.

Bytes identified in Receive Trigger Setup

Port 5 SmartCard

Port 6 SmartCard
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3. Enter the last 2 bytes of trigger 1:  20 06

4. Click OK.

5. Click the port 6 SmartCard and select the Display Counters  command.

6. Click Start  on the port 5 SmartCard to send traffic.  Watch the Trig 1  counters.

Since Trigger 1 represents stream 1 which is 1/20th of the total traffic sent, the Trig 1 count of 517,574
is close to the expected count of 517,558.  The extra triggers may result from a number of causes,
including duplicate packets sent, management packets, or counters not cleared.
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Capturing Packets

1. To capture packets (up to a maximum of approximately 500 packets) and look at the packet content,
click the receive SmartCard, and select the Capture command. Keep the setting for All Packets .

2. Click the Start  button on the transmitting SmartCard, and watch the Capture window.  Note that all
triggers contain the Netcom Systems signature symbol S but that the stream trigger (T) packets are
distinguished from all other stream packets.

Packet Status codes are:

A Alignment T Trigger

C CRC U Undersize

I Interframe gap subminimum V VLAN tag

S Signature
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3. Repeat previous steps 1 and 2 but select the Capture Packets with Rx Triggers  button.



32        How to Test Layer 3 Switches

Appendix A
Sending PING, SNMP, and RIP Frames
In the Layer 3 Setup window (see Procedure 3), you can select Ping, SNMP, and RIP traffic to send.  The
SNMP and RIP frames are static frames based on RFC 1944 and which can be counted in the
SmartWindows Tx from stack or Rx to stack  counters.

Typical values are:  Ping frequency 10, SNMP frequency 100, and RIP frequency 200.

To set and send a ping, refer to Procedure 4, Pinging to Check Links, on page 14.

ARP counters

PING counters
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Appendix B
Editing Frames
In Layer 3 mode, you can edit the packet content for each byte of a custom VTE stream or you can edit
the valid parameters of a packet set up with a specific protocol.

WARNINGS     For a specific protocol such as IP or UDP , you should only edit the valid protocol
parameters.

The last 18 bytes  of EACH layer 3 mode stream is RESERVED FOR SMARTBITS usage.  Any
values inserted into a custom packet in the last 18 bytes will be overwritten.

The Custom packet view-window also allows you to see the byte location of protocol parameters;
however, it is important to edit ONLY the parameters specifically set up for that protocol.

Creating Custom Packets

1. Click on the ML-7710 SmartCard and select Transmit Setup .

2. Double-click on the VTE stream, set the Protocol type to Custom .  Click the Edit  button. Note that
there are no parameters assigned to the custom packet bytes.

3. Here you can edit the packet contents according to the custom packet you wish to create.

4. Use the File menu Save As  command to save your parameters to a .s (S-Record) file for repeated
use.  Then click the close-X button. Then OK.

Viewing Byte Location of a Protocol Parameter

5. In the Frame Editor window, now select the Protocol menu IP-UDP command.  The first packet
checksum (csum) is for IP and listed first; the second checksum is for the UDP packet.

If you click inside a parameter such as TTL, the number 10 value turns blue inside the byte editor
area -- so the exact location of specific parameters appears quickly and easily.
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     UDP Example

Example of what not to do

This is an IP packet which has been edited in the underlined section;  SmartBits will overwrite the last
18 bytes of the packet.   This packet should be a custom packet, not an IP packet. To be usable as a
custom packet, the frame length would have to be extended to 72 bytes.

The IP packet checksum is 2EA8.

The UDP checksum is BD7A

DO NOT EDIT the last 18
bytes of a frame.
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Repeating a custom frame in another stream or card

To insert the protocol data in layer 3 mode (or on another card):

1. Set the length to the same value as the saved file. Select CUSTOM from the protocol field.  Click the
Edit button.

2. Select Open  from the Custom frame editor File menu.

3. Select a previously saved file such as cb_pkt.s .

4. Save (File menu Save As  command), update (Actions menu Update  command), and transmit (click
Start  command on transmitting SmartCard), as required.
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Appendix C
Tips for Testing a Specific Parameter
For example, to test the ToS (Type of Service) parameter, you can set the ToS parameter in the IP packet
as a trigger. Then view the SmartCounters for the trigger and/or capture the trigger packets.  Note the
following sequence.

1. Click on the port 5 SmartCard, select Transmit Setup, and double-click on a VTE IP stream.

2. Select Custom  as the Protocol, then in the Frame Editor, select IP from the Protocol menu.  This
allows you to VIEW the parameter byte locations on the right side and EDIT valid parameters on the
left side.

Parameter Sidebar for editing                            Byte Location Area for View-Only

WARNINGS     For a specific protocol such as IP or UDP , you should edit ONLY the parameters
which appear in the Parameter Sidebar or which appear when you click the Edit button below the
protocol entry.

The last 18 bytes  of EACH layer 3 mode stream is RESERVED FOR SMARTBITS usage.  Any
values inserted into a custom packet in the last 18 bytes will be overwritten.

3. Here we edited the ToS field to be type 2, which appears at byte 16 (therefore the offset is 15). Select
File menu Save command. Click the Close X button. Click OK.

4. To set the receive trigger on the port 6 receive card, set the offset to 15 bytes, and enter 02 as the
value to set the trigger.  Click OK.

   Close button
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Then click on the port 6 SmartCard and select the Capture  command. In the Layer3 Capture Setup
window, click on the selection:

 b Packets with Rx Triggers

5. Click the Start  button on the transmitting SmartCard and watch the Capture window.
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